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Legal Notices
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The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
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Copyright Notices
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Portions created by gSOAP are copyright © 2001-2004 Robert A. van Engelen, Genivia Inc. All Rights 
Reserved. Copyright © 1991-2005 Unicode, Inc. All rights reserved. Distributed under the Terms of Use in 
http://www.unicode.org/copyright.html.

Trademark Notices
Java™ and all Java based trademarks and logos are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries.
Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.
Unix® is a registered trademark of The Open Group. 
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

You can visit the HP software support web site at:

www.hp.com/go/hpsoftwaresupport 

HP software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract. To find more information about access levels, go to:

h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:

h20229.www2.hp.com/passport-registration.html
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1 Planning for an HP Service Manager 
Implementation
This chapter describes the ways in which you can implement HP Service 
Manager 7.00 in your organization.

Topics in this section include:

• Types of Installation Environments on page 12

• Components of a Production Environment on page 13

• Implementation Checklist on page 18
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Types of Installation Environments

You can install Service Manager in several types of environments:

• Production environment

• Non-production environments

— Development environment

— Test environment

— Reporting environment

Production Environment

Installing Service Manager in a production environment allows you to deploy 
your customizations and provide services to your intended user base. Most 
production environments run 24 hours a day and 7 days a week, support many 
simultaneous users, and process large numbers of transactions and requests. 
In a production environment, you typically install the various components of 
Service Manager on dedicated servers to maximize system performance.

Non-Production Environments

The following sections describe some of the common non-production purposes 
for which you can install Service Manager.

Development Environment

Installing Service Manager in a development environment allows you to 
evaluate application features and customize your installation prior to 
deployment in a production environment. In a development environment, you 
typically install all Service Manager components on one test system with a 
limited number of users and data.
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Test Environment

A test environment is an installation that mirrors your production 
environment where you can test performance, upgrades, and backup and 
restore procedures. In a test environment, you typically install Service 
Manager in the same configuration as your production environment.

Reporting Environment

A reporting environment is an installation that mirrors the data from your 
production environment that you can use to generate and view reports. In a 
reporting environment, you typically install Service Manager to synchronize 
data with your production environment but limit the number of users that 
access the system.

Components of a Production Environment

A production environment consists of the following components:

Table 1 Components of a production environment

Tier Requirement Components

Client tier Mandatory web clients (optional)
Windows clients

Server tier Mandatory Service Manager server

Database tier Mandatory RDBMS on separate server (required)

Web tier Optional Web application server on separate server
Web server on separate server
Service Manager webtier-7.00.war file deployed

Supporting servers Optional Help Server

Additional connections  
and integrations

Optional HP products
Web services
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Client Tier

The client tier consists of two components:

• web client (optional)

• Windows client

The web client allows users to connect to the Service Manager server via a 
web browser. You must install the web tier to support web clients. You do not 
need to install or download any additional software on the user’s desktop.

The Windows client allows users to connect to the Service Manager server via 
a dedicated client. You must install the Windows client separately on each 
system that you want to connect to Service Manager.

See the What's New in Service Manager 7.00 online help for a list of 
differences between the web and Windows clients.

Server Tier

The server tier consists of the Service Manager server. The Service Manager 
server runs the Service Manager applications and manages the connections 
between the client and web tiers to the database tier.

See the What's New in HP Service Manager 7.00 online help for a list of 
changes to the Service Manager server. See the HP Service Manager 7.00 
Upgrade Guide before upgrading your server.

Database Tier

The database tier consists of one or more supported RDBMS servers. Your 
Service Manager application data must reside on an external RDBMS server.

For more information, see Database Preparation on page 21.
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Web Tier

The web tier is an optional feature that consists of the following components:

• Web application servers

• Web servers

• Service Manager webtier-7.00.war file

The web application servers are third-party server software where you deploy 
the webtier-7.00.war file to support connections from Service Manager web 
clients.

The web servers are third-party server software that provide the HTTP or 
HTTPS content to Service Manager web clients. Some web application servers 
also include built-in or bundled web servers.

The Service Manager webtier-7.00.war file is a web archive that you must 
deploy to a compatible web server to support connections from Service 
Manager web clients.

See the Service Manager Compatibility Matrix for a list of acceptable web 
application servers and web servers. The HP Support matrices require that 
you register as an HP Passport user and sign in.

To register for an HP Passport ID, go to: 
http://h20229.www2.hp.com/passport-registration.html.

If you already have an HP Passport account, go to: 
http://support.openview.hp.com/sc/support_matrices.jsp.

Help Server

The Help Server is a preconfigured web server that provides HTML Help to 
Service Manager clients and as a stand-alone web page. See Help Server 
Installation on page 91 for more information on this optional feature.
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Additional Integrations

The following HP products are integrated with the HP Service Manager 
server: 

• HP AssetCenter (via Connect-It)

• HP DecisionCenter (via Connect-It)

• HP UCMDB (via Connect-It)

• HP Business Availability Center (via Connect-It)

• HP Configuration Management (via Connect-It)

• HP Operations Manager for Windows (via SCAuto)

• HP Operations Manager for Unix (via SCAuto)

• HP Network Node Manager (via SCAuto)

See the Service Manager Compatibility Matrix for a complete and up-to-date 
list of HP integrations. The HP Support matrices require that you register as 
an HP Passport user and sign in.

To register for an HP Passport ID, go to: 
http://h20229.www2.hp.com/passport-registration.html.

If you already have an HP Passport account, go to: 
http://support.openview.hp.com/sc/support_matrices.jsp.
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These components are logically connected as depicted in the following 
diagram:
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Implementation Checklist

The Service Manager 7.00 release offers a wide variety of significant new 
features. There are various configuration and deployment options that you 
should consider from the start to maximize the benefits of the product, ease its 
integration into your environment, and provide a foundation for future 
support and updates. The checklist below provides of considerations and 
recommended steps that you can incorporate into your implementation and 
upgrade plans.

Follow these steps to implement Service Manager:

1 Determine the hardware required for your Service Manager production 
environment.

For an estimate of the server hardware required, see the Basic Server 
Sizing Worksheet for instructions. This worksheet is available for 
download from the Customer Support web site’s Knowledge Base.

2 Are you upgrading from ServiceCenter?

Yes. See the HP Service Manager 7.00 Upgrade Guide for instructions.

Are you migrating from Service Desk to Service Manager 7.00?

Yes. See the HP Service Manager 7.00 Migration Guide for instructions.

3 Configure a connection to your RDBMS.

See Database Preparation on page 21 for instructions.

4 Install Service Manager server in a development environment.

See Server Installation on page 33 for instructions.

5 Determine the clients (Windows and/or web) that will connect to Service 
Manager.

See the Choosing Clients Worksheet for instructions. This worksheet is 
available for download from the Customer Support web site’s Knowledge 
Base.

6 Do you need to install Windows clients?

Yes. Review the Windows client installation requirements. See Client 
Installation on page 63 for instructions.
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7 Do you need to support web clients?

Yes. Install the Service Manager web tier in a development environment. 
See Web Tier Installation on page 73 for instructions.

8 Do you want to provide online help?

Yes. Install the Help Server. See Help Server Installation on page 91 for 
instructions.

No. Go to step 9.

9 Do you want to make customizations to your Windows clients such as 
changing the splash screen, adding custom images, adding company 
branding, adding default settings and connections, and configuring 
connections to a Help Server?

Yes. Install the Client Configuration Utility. See Client Configuration 
Utility Installation on page 99 for instructions.

No. Install Windows clients in your development environment, and then 
go to step 12.

10 Customize a Windows client with the Client Configuration Utility.

See Client Configuration Utility Installation on page 99 for instructions.

11 Deploy the customized Windows client to your development environment.

12 Tailor the Service Manager applications to your environment.

a Add or update the operator records in your development environment 
with new capability words.

See the Service Manager online help for instructions on adding new 
operators and a list of new capability words.

b Optimize the Service Manager interface in your development 
environment. For example, you can add public favorites and 
dashboards, tailor forms for viewing in the web tier, and tailor forms 
for accessible-assisted users.

See the Service Manager online help for instructions on adding new 
favorites and dashboards, tailoring forms for the web tier, and 
addressing the needs of accessible-assisted users.

c Configure the Service Manager server to accept connections and 
integrations from external data sources and applications such as 
Change Calendar, Connect-It, Decision Center, and Web Services.
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See the Service Manager online help for instructions on enabling 
integrations to other applications.

See the Service Manager Compatibility Matrix for a list of 
applications that can connect to and share data with Service Manager. 
The HP Support matrices require that you register as an HP Passport 
user and sign in.

To register for an HP Passport ID, go to: 
http://h20229.www2.hp.com/passport-registration.html.

If you already have an HP Passport account, go to: 
http://support.openview.hp.com/sc/support_matrices.jsp.

13 Test your development environment.

Review your client and server customizations, client connections, and 
overall system performance. Correct any problems and retest the 
development environment.

14 Convert or push your development environment to your production 
environment.

To convert the development environment connect the Service Manager 
server to your production environment network and deploy necessary 
clients to the production environment.

To push the development environment to your production environment, 
create an unload file of your application and operator customizations and 
load the file into your production environment system. See the Service 
Manager online help for instructions.
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2 Database Preparation
This chapter explains database configuration requirements that must be met 
prior to installing the HP Service Manager database into your Relational 
Database Management Systems (RDBMS).

This chapter should be reviewed by system and database administrators 
preparing to install the HP Service Manager server.

Topics in this section include:

• General Space Requirements on page 22

• Server connections on page 22

• Login ID on page 22

• Setting up time zones for RDBMS reporting on page 23

• Enabling connectivity on page 23

• IBM DB2 Universal Database Preparation on page 24

• Microsoft SQL Server Preparation on page 26

• Oracle Server Preparation on page 28

• Installing the Sample Database on page 31
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General Space Requirements

If you are establishing a new Service Manager system, allocate at least 1 GB 
of data space for a test system. The amount of space necessary for a 
production system varies depending on the amount of data you need to store 
and your specific implementation. 

Server connections

Every Service Manager thread, foreground or background, requires a 
connection to your RDBMS server. Service Manager background processors 
require 17 connections to run. When you configure your database, make sure 
that you allocate enough connections for all of your users. For additional 
information, refer to your RDBMS vendor documentation.

Login ID

Create a login ID and password for Service Manager to use to connect to your 
RDBMS server. The login must have CREATE/ALTER/DROP TABLE 
authority for the target database. When you log in to Service Manager, it 
creates a table in the default table space defined for that login ID. 

Place all Service Manager data in a dedicated table space within a 
single-instance of your RDBMS. This table space must contain Service 
Manager data only. Multiple instances consume more system resources than 
a single-instance solution.

CREATE/ALTER/DROP TABLE authority is only required during 
installation and creation of new Service Manager tables, and only if you allow 
Service Manager to issue the DDL to create tables and indexes. 
22 Chapter 2



Setting up time zones for RDBMS reporting

If you plan to report on Service Manager data using RDBMS tools, set the 
sqltz parameter in sm.ini file before conversion. 

For information about using the sqltz parameter, see the System Parameters 
topic in the Service Manager Help. 

Enabling connectivity

Service Manager connects to the database through either an ODBC 
connection (SQL Server) or through an RDBMS client (Oracle and DB2 
Universal). 

To set up the connection between the Service Manager application server and 
your RDBMS, you will need the following information:

• Name of the database. 

• Login and password required to connect to the database server. This is the 
login and password created in Login ID on page 22.

The Service Manager initialization file is called sm.ini. It must be present in 
the Service Manager server RUN directory. You can set the Service Manager 
server parameters in the sm.ini file. 

After you create the connection using either ODBC or the utilities for your 
RDBMS client, you can run the configuration utility, which verifies the 
connection and load the system to the RDBMS.

If you use different time zone settings after conversion, the dates contained in 
reports made by your RDBMS utility may be inaccurate. 
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IBM DB2 Universal Database Preparation

This section outlines the tuning and optimization recommendations when 
using Service Manager with IBM DB2 Universal Database 8.x for Microsoft 
Windows and Unix. These recommendations are intended only as a guide and 
should not be implemented on a production system without extensive testing. 

The following recommendations assume the use of SMS table spaces and the 
implementation of conventional database tuning and performance measures. 
Actual results may vary on a system-by-system basis based on the tuning 
expertise available and hardware and software selections. 

Complete the following procedures prior to the initial load of your database: 

Task 1: Allocate data space large enough to hold your data. See General Space 
Requirements on page 22. 

Task 2: Allocate enough additional server connections for all your users. See Server 
connections on page 22. 

Task 3: Create a login ID and password for Service Manager to use when it connects to your 
RDBMS server. See Login ID on page 22. 

Task 4: If you plan to report on Service Manager data using RDBMS tools, set up time zones. 
See Setting up time zones for RDBMS reporting on page 23. 

Page Size

The default page size in DB2 is 4096 bytes (4 KB) Service Manager requires 
32768 byte (32 KB) pages. Be sure to create a 32 KB page size buffer pool, 
table space, and system temporary table space. Using this page size reduces 
the disk space and the resources needed to perform joins.

A fully qualified DB2 administrator should assist with this preparation.
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Enable the Database for Multipage File Allocation

Enabling multipage file allocation causes DB2 to allocate new data pages in a 
table space one multipage extent at a time rather than one page at a time, 
which reduces overhead of large insert operations. 

Follow these steps to enable multipage file allocation:

1 As the instance owner, disconnect all applications from the database.

2 Run the following command:

db2empfa <dbname>

Catalog the Database

Follow these steps to catalog the database:

1 Install the DB2 client on your Service Manager server.

2 Catalog the database you want to connect to by using the DB2 client 
utilities.

3 Use the name you defined when you performed the catalog operation as 
the database name for the configuration tool.

Code Page Considerations

Create your Oracle or DB2 database with a UTF-8 code page for use with 
Service Manager. All data passed from Service Manager to the RDBMS client 
is encoded in UTF-8, therefore using a UTF-8-based RDBMS will reduce 
overhead for converting data and prevent loss of special characters.

Enable multipage file allocation on SMS table spaces only. 
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Microsoft SQL Server Preparation

This section provides details on the implementation of the Microsoft SQL 
Server 2000 and 2005. It builds from the premise that Service Manager and 
Microsoft SQL server have already been installed. If the SQL server has not 
yet been installed, specify the desired case sensitivity for sort order during the 
creation of the database.

Complete the following procedures prior to the initial load of your database: 

Task 1: Allocate enough additional server connections for all your users. See Server 
connections on page 22. 

Task 2: Create a login ID and password for Service Manager to use when it connects to your 
RDBMS server. See Login ID on page 22. 

Task 3: If you plan to report on Service Manager data using RDBMS tools, set up time zones. 
See Setting up time zones for RDBMS reporting on page 23.

Task 4: Tune server data for conversion. 

Limiting the Transaction Log Size for Microsoft SQL Server

During initial system load, Service Manager places a high insert transaction 
load on your SQL server. To prevent the transaction log from growing too 
large, set  the Truncate Log On Checkpoint option for the target database on 
your SQL server.

A fully qualified Microsoft SQL server administrator should assist with this 
preparation.
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Microsoft SQL Server Connectivity

General connectivity rules:

• The database name entered in the configuration tool must correspond to 
an ODBC system data source.

• Configure the ODBC data source as a System DSN. Set it up to use:

— SQL server authentication

— ANSI quoted identifiers

— ANSI nulls, paddings, and warnings

Case Sensitivity

Service Manager only supports case sensitivity with Microsoft SQL Server 
2000 and 2005 databases. Set the database to the desired configuration when 
you created it. Service Manager will automatically detect the settings and 
perform correctly.

Code Page Considerations

SQL Server does not support a UTF-8 code page. Choose a code page that 
supports most of your required characters. 

To use HP Service Manager in case insensitive mode, you must select a case 
insensitive code page on the SQL Server before installing HP Service 
Manager.

If you are loading data from a case-sensitive system there is the potential for 
some records to be dropped because they will cause a duplicate key error on 
loading. This is the expected and proper behavior. For example, the sample 
system contains both the falcon and FALCON operator records. When loading 
into a case-insensitive server, only the FALCON record loads. The load tries 
to insert falcon after FALCON, and it is rejected.

If you choose a Western European code page, no Eastern European or Asian 
characters can be stored.
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Oracle Server Preparation

Complete the following procedures prior to the initial load of your database:

Task 1: Allocate data space large enough to hold your data. See General Space 
Requirements on page 22.

Task 2: Allocate enough additional server connections for all your users. See Server 
connections on page 22. 

Task 3: Create a login ID and password for Service Manager to use when it connects to your 
RDBMS server. See Login ID on page 22. 

Task 4: If you plan to report on Service Manager data using RDBMS tools, set up time zones. 
See Setting up time zones for RDBMS reporting on page 23.

Task 5: Make sure that your tables are set up properly. See Setting Up Oracle Tablespaces 
and Users on page 28. 

Task 6: Define a table space.

Task 7: Set the RDBMS environmental variables.

Setting Up Oracle Tablespaces and Users

Most tables on an Oracle server hold less than 50 KB of data. Service Manager 
sets the initial storage space size when creating the SQL tables. 

When manually creating a new Oracle instance for Service Manager:

• Create the database with a block size of 8 KB or a multiple thereof. 

• Create a separate table space for the Service Manager data, and make this 
the default table space for the Service Manager user. 

• Set the TEMPORARY table space for the Service Manager user to an 
appropriate temporary table space.

A fully qualified Oracle administrator should assist with this preparation.
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Set the Oracle Environment Variable

Follow these steps to set your Oracle environment variable:

1 Find the path where your shared libraries are located. 

2 Set the environment variable as shown in the following examples. In these 
examples, the path is set in the environment variable ORACLELIB.

C shell: setenv LD_LIBRARY_PATH $LD_LIBRARY_PATH: 
$ORACLELIB

Korn shell: export LD_LIBRARY_PATH = $LD_LIBRARY_PATH: 
$ORACLELIB

Set the sqldb Parameter

The sqldb parameter in the sm.ini file specifies the name of the Oracle 
database connection. The connection name is defined in the tnsnames.ora file. 

• On Unix platforms, the tnsnames.ora file is located in $ORACLE_HOME/
network/admin or can be specified using the TNS_ADMIN environment 
variable.

• On Windows platforms, the tnsnames.ora file is located in the Oracle 
Home [%ORACLE_HOME%/network/admin] directory.

Set Up Oracle Connectivity

Follow these steps to set up connectivity to your Oracle database:

1 Install the Oracle client on your Service Manager server.

2 Configure a connection to the Oracle server in the tnsnames.ora file.

3 In the configuration tool, name the database by using the name you 
provided in the tnsnames.ora file.
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Code Page Considerations

Create your Oracle or DB2 database with a UTF-8 code page for use with 
Service Manager. All data passed from Service Manager to the RDBMS client 
is encoded in UTF-8, therefore using a UTF-8-based RDBMS will reduce 
overhead for converting data and prevent loss of special characters.
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Installing the Sample Database

A copy of SQL Express is included on the installation DVD for demonstration 
purposes only. You will need an enterprise-level RDBMS for use in your 
development, test, and production systems. 

Follow these steps to install the sample database:

1 Log in to the Windows server as a user with local administrator privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

3 Click Install SQLServer2005 for use with HP Service Manager for testing 
purposes only.

The SQLServer folder opens.

4 Double-click SetupSQLServer.bat.

5 When prompted, press any key to exit the installation.

The sample database is now installed and has the following properties.

The out-of-box sm.cfg and sm.ini files are set up to work with this database. 
To connect a different database server, edit the configuration and 
initialization files for that server. 

Instance Name: SM700_DEMO

Security Mode: SQL

SA password: SM7DEMO

Database Name: SM7DEMO

Collation: Latin1_General_BIN
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3 Server Installation
You can install HP Service Manager on a Windows or Unix server. This section 
contains information about installation requirements and how to install the 
server. For information about starting and stopping servers, see the HP 
Service Manager to the Service Manager online help.

Topics in this section include:

• Installing the Server on Windows on page 34

• Installing the Server on Unix on page 40

• Installing AutoPass on page 51

• Obtaining Product Licenses on page 54

• Server Configuration on page 60

Refer to the HP Service Manager Upgrade Guide for instructions on how to 
upgrade the server. 

For instructions on how to install the Knowledge Management search engine, 
see Search Engine Installation on page 111.

Before you can install the Service Manager server on AIX HP-UX and Solaris 
systems, you must install JVM 1.5. Refer to the Java documentation for 
instructions on how to install JVM. 
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Installing the Server on Windows

For complete information about current platform requirements and 
compatibility, go to the Customer Support web site at http://www.hp.com/
managementsoftware/support.

Installation Requirements

• Compatible Windows operating system (See the Service Manager 
Compatibility Matrix. *)

• The most current Windows updates for your operating system

• 1 GB RAM minimum recommended

— For production purposes, RAM is based on the expected user load.

• Local administrator account to install on the Windows server

* The HP Support matrices require that you register as an HP Passport user 
and sign in.

To register for an HP Passport ID, go to: 
http://h20229.www2.hp.com/passport-registration.html.

If you already have an HP Passport account, go to: 
http://support.openview.hp.com/sc/support_matrices.jsp.

You cannot run the Service Manager service if you install the system from a 
root account unless you give ownership and permissions to the Service 
Manager administrative user. Create a user ID that will own Service 
Manager.
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System Requirements

Make sure that your system meets the following requirements before 
installing Service Manager.

Server Resources

The Service Manager server uses the following resources.

Table 1 Windows system requirements for server installation

Requirement Resources needed

Disk space 400 MB for server installation

TCP/IP 
service name

During the Service Manager server configuration, the system prompts you 
for a valid TCP/IP port. The port number you choose for Service Manager 
must be greater than 1024. 

Table 2 Service Manager server system resources

Resource Definition

Processes A process starts for each sm command line in the sm.cfg file. By default each 
process is limited to 50 threads. Each user configuration or background 
process uses one thread. 
• If the background processes are started by using the sm system start 

command in the sm.cfg file, the will all be thread owned by this sm 
process. 

• If the background processes are launched for a user session inside Service 
Manager, they will be threads under the same Thread Controller process 
that owns the user session thread.

To allow more than 50 concurrent user sessions, refer to the server scaling 
topics in the online help.

Shared 
Memory

A server uses approximately 48 MB of base shared memory per system plus 3 
MB for each 30 users. 
The shared_memory parameter in the sm.ini file specifies the amount of 
shared memory that Service Manager allocates. 
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Service Manager Server Setup

Follow these steps to install the Service Manager server:

1 Log in to the Windows server as a user with local administrator privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

3 Click Install HP Service Manager Server for Windows.

The Service Manager Server setup wizard opens.

4 Click Next to read and accept the licensing agreement.

5 Select the I accept the terms in the License Agreement option.

The Next button becomes active.

6 Do one of the following:

• Click Next to accept the default installation folder.

The default installation folder is: 
C:\Program Files\HP\Service Manager 7.00\Server\

• Click Browse to choose a different installation location.

See the HP Service Manager 7.00 Upgrade Guide for more information 
about upgrading the server from previous versions.

7 Click Next to prepare the installation process.

The summary information page opens.

Do not install the server over existing versions of ServiceCenter or 
Service Manager. You must install into a new folder. 

You must install the Service Manager server in a folder containing 
only ASCII characters in the folder name. The server cannot start if 
installed in a folder with non-ASCII characters in the folder name.
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8 Click Install to begin copying the installation files.

You can stop the installation by clicking Cancel.

The Completing the Service Manager Server Setup wizard page opens 
when the installation is complete.

9 To automatically configure the server, select the Configure Server option.

10 Click Finish to exit the Setup wizard.

The server installation is complete.

If you selected the Configure Server option, the Configuring HP Service 
Manager Server wizard opens. Complete the steps in Server Configuration 
on page 60.

11 After the configuration steps are complete, close the browser window, or 
click the next item you want to install.

Uninstalling the Windows Server

You can uninstall the server in one of two ways:

• Uninstall the server from Add/Remove Programs. See Uninstalling from 
Add/Remove Programs on page 38.

• Uninstall the server from the Service Manager installation DVD. See 
Uninstalling from the Installation DVD on page 38.

The Autopass installation box opens and installs autopass 
automatically. Do not click Finish until the autopass installation is 
complete.

You can also configure the Service Manager server by editing the 
sm.ini configuration file. See Server Configuration on page 60.

The server uninstall process intentionally preserves all database files and 
server configuration settings. You must manually remove these files if you are 
completely uninstalling Service Manager from your system. HP recommends 
that you delete the entire server installation folder if you do not want to 
preserve any existing server data.
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Uninstalling from Add/Remove Programs

Follow these steps to uninstall the server from Add/Remove Programs:

1 Stop the Service Manager service.

For information about stopping the server, refer to the HP Service 
Manager online help.

2 From the Windows main menu, click Start > Settings > Control Panel > Add/
Remove Programs.

The Add/Remove Programs dialog box opens.

3 Scroll to the Service Manager server program and click Remove.

A message prompts you to verify removing the program.

4 Click Yes.

The process takes several minutes. Additional messages indicate the 
progress of the uninstall.

When you complete the uninstall, you return to the Add/Remove 
Programs dialog box.

5 Click Close.

Uninstalling from the Installation DVD

Follow these steps to uninstall the server from the installation DVD:

1 Stop the Service Manager service.

For information about stopping the server, refer to the HP Service 
Manager online help.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. 
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If auto-run is disabled, you can manually start the DVD browser by using 
one of the following methods:

• Use Windows Explorer to navigate to the DVD directory. Double-click 
autorun.exe.

• Start the Service Manager installation from the Windows command 
prompt. Type the following:

D:\>autorun

where D identifies the DVD drive. Substitute your DVD drive 
identifier.

3 Click Install Server.

The Service Manager installation wizard opens.

4 Click Next.

The Remove the Program window opens.

5 Click Remove.

The process takes several minutes. Additional messages indicate the 
progress of the uninstall. After the operation is complete, the InstallShield 
Wizard Completed page opens.

6 Click Finish.

7 Click Exit Install to close the DVD browser.
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Installing the Server on Unix

For complete information about current platform requirements and 
compatibility, go to the Customer Support web site at http://www.hp.com/
managementsoftware/support.

System Requirements

Make sure that your system meets the following requirements before 
installing Service Manager.

Table 3 Unix system requirements for the server installation

Requirement Resources needed

Disk space 400 MB for server installation

Java Service Manager requires Java version 1.5 to be installed on the system. 
Either the JDK or JRE can be used and Service Manager will search for it 
at install time. Users running Linux on Intel x86 platforms do not need to 
install Java; Service Manager includes Java for that platform.

TCP/IP 
service name

During the Service Manager server configuration, the system prompts you 
for a valid TCP/IP port. The port number you choose for Service Manager 
must be greater than 1024. 

User and  
group ID

Before installing Service Manager, create a new Unix user name and group 
ID exclusively for administrators who install, run, and maintain Service 
Manager. Service Manager uses the setuid feature of the Unix operating 
system to maintain the security of the file system and Unix resources. 
Create a user name that is different from the names of Service Manager 
executables. For example, sm is inappropriate. Use the new administrative 
user name to install Service Manager.

You cannot run the Service Manager service if you install the system from a 
root account unless you give ownership and permissions to the Service 
Manager administrative user. Create a user ID that will own Service 
Manager.
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Server Resources

The Service Manager server uses the following resources.

Other Information

Review the following information before you install Service Manager.

Table 4 Service Manager server system resources

Resource Definition

Processes A process starts for each sm command line in the sm.cfg file. By default each 
process is limited to 50 threads. Each user configuration or background 
process uses one thread. 
• If the background processes are started by using the sm system start 

command in the sm.cfg file, the will all be thread owned by this sm 
process. 

• If the background processes are launched for a user session inside Service 
Manager, they will be threads under the same Thread Controller process 
that owns the user session thread.

To allow more than 50 concurrent user sessions, refer to the server scaling 
topics in the online help.

Semaphores Service Manager uses 16 semaphores, regardless of the number of users 
logged on to the system.

Shared 
Memory

A server uses approximately 48 MB of base shared memory per system plus 3 
MB for each 30 users. 
The shared_memory parameter in the sm.ini file specifies the amount of 
shared memory that Service Manager allocates. 

Table 5 Additional Unix requirements

Topic Description

ANSI 
Terminal

The installation scripts assume that you are running on an ANSI terminal. If 
the scripts run on a non-ANSI terminal (such as the hpterm), the results may 
be undesirable.

Root 
Access

These installation procedures may require root access for system kernel 
modifications or for initially mounting the Service Manager DVD, but not for 
installing the software.
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Preliminary Steps

The following convention identifies variables that may change depending on 
your particular installation:

<variable>

As you go through the installation steps and see a variable in brackets, 
remember that you can assign a different value to the variable. Do not type 
the brackets (< >) as part of the command.

Prior to installation, determine where to install Service Manager. 

Your library path and path variables need to include the appropriate RDBMS 
client directories. You need to add the RDBMS client directories and <sc>/RUN 
to the library path before you can start Service Manager with the smstart 
command. You can add these directories as part of the shell login or part of a 
profile script. 

You can provide the necessary library path by modifying the following 
environment variables.

Refer to your operating system documentation for more information on how to 
set environment variables.

Add the Service Manager RUN directory to beginning of the existing value 
string. If a statement does not exist, create a new statement that points to the 
Service Manager RUN directory. 

The installation script creates the directory, but the user running the script 
must have sufficient permissions to create the new directory.

Table 6 Environmental variables

OS Environmental variable to set

AIX LIBPATH

HP-UX SHLIB_PATH

Linux and Solaris LD_LIBRARY_PATH
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For example: On Linux, using the bash shell, the following commands added 
to the ~/.profile file set the library path properly:

In this example, replace <sm> with the base directory of the Service Manager 
installation.

Installing the Server

Follow these steps to install the Service Manager server:

1 Before installing the server, install AutoPass by following the instructions 
in Installing AutoPass on page 51.

2 Mount the DVD, and change directories to the mount location.

3 Run the executable script that matches your system, for example:  
./setupsolaris -console for Solaris systems or  
./setupaix -console for AIX systems.

4 At the installation script prompt, you must Accept in order to proceed.

5 At the installation script prompt, type the installation directory address 
where you want to install Service Manager. 

6 The system takes several minutes to read the contents of the DVD, 
uncompress the files, and complete the server installation in the specified 
directory. 

7 Click Finish to exit the Wizard.

set LD_LIBRARY_PATH=.:<sm>/RUN:$LD_LIBRARY_PATH
export LD_LIBRARY_PATH

Do not install the server over existing versions of ServiceCenter or 
Service Manager. You must install into a new folder. 

The system validates any directory name that you specify. If you 
specify an invalid directory, the installation generates an error 
message.

Do not use the "~" symbol when entering the path. InstallShield 
treats this as a regular character, and will create a directory with 
the name '~'.
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8 To automatically configure the server, run the configure script, which is 
found in your <Install path>/directory to update the sm.cfg file. Go to 
Server Configuration on page 60 for instructions.

Uninstalling the Service Manager Server

Follow these steps to uninstall the Service Manager server:

1 Stop the Service Manager server.

2 Delete all the Service Manager server directories and subdirectories.

Kernel Resource Requirements

Service Manager server requires both shared memory and semaphores to run. 
On most Unix systems, you can configure these resources through kernel 
configuration parameters.

The kernal configuration supports the use of Unix IPC (inter-process 
communication) functions by Service Manager. Each new connection spawns a 
new sm process. All these processes then use IPC to talk to each other and to 
manage shared resources.

You can also configure the Service Manager server by editing the 
sm.ini configuration file. See Server Configuration on page 60.

The following kernel resource requirements are the minimum values required 
for running a Service Manager server. Add these values to the current or 
default settings to run Service Manager concurrently with other programs or 
products on your system.

For all platforms, shared memory maximum units are expressed in 
megabytes (MB). For example, the shmmax value for an HP-UX server with 30 
users is 11534336 bytes (11 MB).
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AIX Server

You do not need to adjust your kernel configuration on AIX systems because 
they are self-adjusting.

HP-UX server

Shared Memory

Processes

Table 7 Shared Memory requirements

Kernel 
setting Recommended Calculation

shmem 1 byte

shmmax 51 MB 48 MB for each Service Manager system  
+ 3 MB per 30 users

shmmni 1 byte per Service Manager system

Table 8 Processes requirements

Kernel 
setting Calculation

maxuprc 5 + 1 per background scheduler + 1 per Service Manager user

nproc 5 + 1 per background scheduler + 1 per Service Manager user
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IPC Parameters

Use the SAM utility to configure kernel IPC parameters on HP-UX.

Before you start SAM, define the DISPLAY environment variable. For example, 
if the name of your host (or X terminal) is eagle, type the following command 
at your shell prompt.

• If you use the Bourne or Korn shell:

• If you use the C Shell:

Follow these steps to configure kernel IPC parameters:

1 Start SAM.

2 Select the Kernel Configuration option from the main menu.

3 Select the Configurable Parameters option.

4 Modify the kernel parameters as specified in IPC Parameters on page 46.

When you finish modifying the necessary parameters, the SAM utility guides 
you through the steps to restart the system. Restarting is necessary to 
activate the changes.

Maxdsiz Parameter

The HP-UX maxdsiz parameter sets the maximum data segment size for each 
process. This data segment can consist of virtual memory (swap space) and 
real memory. The system attempts to meet your requirements with real 
memory. It uses swap space to make up the difference until it reaches the 
maxdsiz limit.

Each Service Manager user requires approximately 1 MB of physical memory 
(resident set size on Unix). You must set the server platform memory size to 
support the maximum number of users that log in to Service Manager 
concurrently. For example, if you have 100 Service Manager users, set the 
maxdsiz parameter to 100 MB or more.

You need to be a root user or have superuser capabilities before you start the 
SAM utility.

DISPLAY=eagle:0 #
export DISPLAY

setenv DISPLAY eagle:0
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You do not need to increase the value of the maxdsiz parameter above the 
number of users on the system unless you have processes that use large 
amounts of static data storage space. Do not set the maxdsiz value to the 
maximum size of 944 MB because private memory-mapped files and 
shared-library data also occupy space in the dynamic storage region.

The following values are acceptable.

The system returns an error to the calling process if the maxdsiz value is too 
low for the number of users and running processes. A setting that is too low 
may cause the process to terminate.

You can change the maxdsiz parameter by using the SAM utility process 
described in IPC Parameters on page 46.

Linux Server

The default shared memory limit (both SHMMAX and SHMALL) is 32 MB, 
but it can be changed in the proc file system without restarting the system. 
For example, to specify 128 MB:

You can use sysctl.conf to control these parameters. Add the following lines to 
the/etc/sysctl.conf file:

This file is usually processed at startup, but sysctl.conf can be called later.

The Linux security feature, exec-shield-randomize, must be turned off when 
you start up the Service Manager server. The out-of-box smstart script sends 
you an error message and does not start the server if exec-shield-randomize is 

Table 9 Maxdir settings

Maxdsiz setting Value

Default 0x4000000 (64 MB)

Maximum 0x3B03100 (944 MB)

Minimum 0x400000 (4 MB)

# echo 134217728 >/proc/sys/kernel/shmall
# echo 134217728 >/proc/sys/kernel/shmmax

kernel.shmall = 134217728
kernel.shmmax = 134217728W
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on. However, if you use your own script instead of smstart, be aware that the 
server can start if exec-shield-randomize is turned on, but it will terminate 
later.

The/proc/sys/kernel/exec-shield-randomize file controls whether Exec-Shield 
randomizes VM mapping. You can turn off exec-shield-randomize by using any 
of the following options:

• Use the following command:

The default value for/proc/sys/kernel/exec-shield-randomize is 1.

• Include the following line in the/etc/sysctl.conf file:

• Include the following line in the/etc/grub.conf file:

Solaris Server

Shared Memory

echo 0 >/proc/sys/kernel/exec-shield-randomize 

kernel.exec-shield-randomize=0

exec-shield=0

Table 10 Solaris shared memory requirements

Kernel setting Recommended Calculation

forceload:sys/shmsys

shmsys:shminfo 
_shmmax

51 MB 48 MB for each Service Manager 
system plus 3 MB for each 30 
users

shmsys:shminfo 
_shmmni

1 byte for each Service Manager system
48 Chapter 3



Processes

Number of File Handles

The default upper limit for file descriptors is 256. You must increase this value 
to at least 512.

Follow these steps to increase the upper limit:

1 Log in to the Solaris server.

2 Run ulimit -a: 

To increase this value to 512, type the following command:

Table 11 Solaris processes requirements

Kernel setting Calculation

maxuprc: 5 + 1 per background scheduler + 1 per Service 
Manager user 

max_nprocs: maxuprc

bash-3.00$ ulimit -a
core file size        (blocks, -c) unlimited
data seg size         (kbytes, -d) unlimited
file size             (blocks, -f) unlimited
open files                    (-n) 256
pipe size          (512 bytes, -p) 10
stack size            (kbytes, -s) 8192
cpu time             (seconds, -t) unlimited
max user processes            (-u) 29995
virtual memory        (kbytes, -v) unlimited

$ ulimit -n 512
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IPC Parameters

You can control kernel parameters with the/etc/system file. The operating 
system reads the/etc/system file at initialization time to define the initial 
kernel parameters.

Follow these steps to configure kernel IPC parameters:

1 Modify the/etc/system file to alter any kernel parameters. By default, the 
IPC system is not enabled. Append the following statements to the end of 
the file:

2 Restart the system to activate the changes. Type:

*/etc/system sample file
* Customize kernel parameters
* These statements initialize the IPC subsystem
forceload: sys/shmsys
forceload: sys/semsys
forceload: sys/msgsys
*
* SEM
set semsys:seminfo_semmap=60
set semsys:seminfo_semmni=100
set semsys:seminfo_semmns=1000
set semsys:seminfo_semmnu=30
set semsys:seminfo_semmsl=50
set semsys:seminfo_semopm=10
set semsys:seminfo_semume=15
set semsys:seminfo_semvmx=32767
set semsys:seminfo_semaem=16384
*
* SHM
set shmsys:shminfo_shmmax=67108864
set shmsys:shminfo_shmmni=100
set shmsys:shminfo_shmmin=1
set shmsys:shminfo_shmseg=10
*
set max_nprocs=1200

cd/
usr/sbin/shutdown -i6 -y -g0
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Installing AutoPass

Preparation

You need to install the appropriate operating system patches before you can 
install AutoPass.

HP-UX 11.0

• PHSS_26945 1.0 HP aC++ -AA runtime libraries (aCC A.03.37) 

• PHCO_27731 1.0 libc cumulative patch

HP-UX 11.11

• PHSS_22898 1.0 HP aC++ -AA runtime libraries (aCC A.03.30) 

• PHCO_24400 1.0 libc cumulative patch

Solaris

32-Bit Shared library patch for C++ 

• Sun OS 5.7: Patch-ID# 106327-22 

• Sun OS 5.8: Patch-ID# 108434-14 

• Sun OS 5.9: Patch-ID# 111711-09

Installation

AutoPass installers for each operating system are included on the installation 
DVD. The AutoPass files are stored on the Service Manager DVD in the 
Server/Unix/autopass directory. 

On Windows platforms, AutoPass installs as part of the server installation. 
On Unix platforms, you must install it manually before you can run Service 
Manager. 
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Install the appropriate file from this location onto your system by using the 
normal software installation mechanism provided by your operating system.

Follow these steps to install AutoPass:

1 Run the following command as "root".

HP-UX

swinstall -s <full-path-to-depot-filename>

Solaris

pkgadd -d <full-path-to-pkg-filename>

Linux

rpm -Uhv <full-path-rpm-filename>

AIX

installp -a -d <full-path-to-bff-filename> HPOvLIC 

Be sure to use the appropriate .depot file for your version. IPF32 
indicates Itanium, other HP-UX files are for PA-RISC.

Be sure to use the appropriate .pkg file for your version.

Be sure to use the appropriate .rpm file for your version.

Be sure to use the appropriate .bff file for your version.

If you plan to turn on a 60-day temporary evaluation license on Unix, you 
must make LicFile.txt writable before running the sm -instantOn 
command. The default location for this file is: /var/opt/OV/HPOvLIC/
LicFile.txt  For more information, see Obtaining Product Licenses on page 54.
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Uninstalling AutoPass

AutoPass is not automatically uninstalled when Service Manager is removed. 

Run the following commands as "root" to remove Autopass:

Solaris

pkgrm HPOvLic

HP-UX

swremove HPOVLIC

Linux

rpm -e HPOvLic

AIX

installp -u HPOvLIC

If you remove AutoPass, Service Manager and other applications that use 
AutoPass will no longer function.
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Obtaining Product Licenses

A license key password is required to use Service Manager. Licensing is 
managed with AutoPass. When the Service Manager software is installed and 
used for the first time, a 60-day trial license is granted (Instant-On). Within 
this 60-day period, you must obtain a perpetual license key password or a trial 
evaluation extension to continue using the product.  

After installing the server you can install a evaluation license by running the 
command "sm -instantOn", which installs an evaluation license valid for 60 
days. 

During the last ten days of the evaluation period, every user who wants to log 
in will see a license expiration warning message. The system administrator of 
the product must go to the webware site (www.webware.hp.com) and 
download the perpetual license to use the product.

If you have not purchased all modules and you would like to consider adding 
some to review during the Instant-On process, please contact your HP account 
manager.

To request perpetual license passwords, you need the following items:

• Entitlement Certificate, which contains the HP product number and order 
number.

• IP address of the server.

• Your company or organization information.

The best way to obtain product licenses is through the website: 
www.webware.hp.com. You can also contact the HP Password Center via 
fax, email, or phone. This information is available on the Password Request 
Form and the License Entitlement Certificate. In order to obtain product 
licenses, you need the License Entitlement Certificate.

On Windows platforms, AutoPass installs as part of the server installation. 
For a Unix platform, AutoPass must be installed manually. The instructions 
for installing AutoPass on Unix are provided in Installing AutoPass on 
page 51.

To run instantOn on Unix platforms, you must make LicFile.txt writable. 
For more information, see Saving Your License Key/Password File to Your 
System on page 58.
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Using the Web Site

Follow these steps to obtain your product licenses:

1 Go to www.webware.hp.com.  
This links you to the web site - HP Password delivery service.

2 Select Generate password(s) on the Webware licensing menu.

3 Type your order number in the Order number text box. You order number is 
found on the License Entitlement Certificate - Password Request Form 
(HP Order Number).

4 Click Next.

5 Select the product you are requesting a password for on the Product 
selection form by clicking the check box for the product.

6 Click Next.

7 Select the product(s) for which you want to request password(s).

8 Click Next.

9 For each product you selected, type the number of Licenses  
To Use (LTUs) - limited by number of LTUs available for the order:

• Server host name

• IP address for the system where the software is installed

10 Click Next.

11 Provide all required information on the Member sign-in form.

12 Click Sign-In.

13 Provide all required information on the Address information form.

14 Click Next.

15 The Receive Permanent Password Certificate form displays a copy of your 
Permanent Password Certificate. It also offers additional delivery options 
for your certificate.
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You should also receive an email containing your password certificate(s) and 
license key/password file attachment(s) similar to the following example.
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To eliminate chances of error, it is highly recommended that license/
password(s) are installed directly from a license key/password file, rather than 
attempting to manually transcribe and edit them from the license/password 
certificate. Each license key/password file can be copied to the appropriate 
target system and then directly imported and installed by the application. No 
editing of the license key/password file is required.

Saving Your License Key/Password File to Your System

As part of the process of obtaining a permanent AutoPass license, a .dat file 
or several .dat files were sent to the email address you provided. These files 
contain the licensing data required to use the appropriate Service Manager 
modules. After you receive these files, you must move them to the Service 
Manager server.

Windows

Follow these steps to save your license key/password file to your system:

1 Rename the .dat file to a .txt file so that you can open it with a text 
editor.

Example: from J8888X1624204.dat to J8888X1624204.txt

2 Create a file, LicFile.txt, to store the license data in. The default 
location for this file is:

C:\Program Files\Common Files\Hewlett-Packard\HPOvLIC 
\data

3 Copy the license data from the license file and paste it in the 
LicFile.txt you created.

You need to create this file only once. If you request any additional 
licenses, you should append those licenses to the end of this file.
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Unix

Follow these steps to save your license key/password file to your system:

1 Rename the .dat file to a .txt file so that you can open it with a text 
editor.

Example: from J8888X1624204.dat to J8888X1624204.txt

2 Create a file, LicFile.txt, to store the license data in. The default 
location for this file is:

/var/opt/OV/HPOvLIC/LicFile.txt

Copy the license data from the license file and paste it in the 
LicFile.txt you created. 

3 Save the file LicFile.txt.

This procedure must be performed by a user with root access.

You need to create this file only once. If you request any additional 
licenses, you should append those licenses to the end of this file.

If you plan to turn on a 60-day temporary evaluation license on Unix, you 
must make LicFile.txt writable before running the sm -instantOn 
command. For more information, see Obtaining Product Licenses on page 54.
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Server Configuration

You can customize your Windows and Unix server installation by modifying 
the HP Service Manager initialization file (sm.ini). 

You can configure the startup parameters that the Windows service uses to 
start Service Manager by editing the configuration file (sm.cfg). Use a text 
editor to open and modify those files. 

Using the Configuration Tool

The configuration tool starts automatically during your Windows server 
installation, if you selected the Configure Server option

Follow these steps to configure the server:

1 Run the Configure Server tool. The

2 Specify the listener ports.

A complete list of the parameters stored in the sm.ini file is available in the 
Service Manager Help.

Table 12 Listener Port Parameters

Parameter Default Description

HTTP Port 
(system)

13080 The communication port number to which 
you want Service Manager to listen to client 
connection requests.

Enable HTTPS 
Port

Select this option to enable an HTTPS port.

HTTPS Port The communication port number to which 
you want Service Manager to listen to 
secure client connection requests.
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3 Specify the database type and connection information.

4 Verify the connection to confirm that Service Manager can connect to the 
database. 

5 Upload the demo data, if desired. 

You must start the server before users can access Service Manager. For 
information about starting the server, refer to the HP Service Manager online 
help.

Setting Up the Server for Languages Other than English

You can change the default from English by editing the Service Manager 
initialization file in a text editor.

Table 13 Database type and connection information

Parameter Description

Database 
Type

The database you want to use to store your data.

SQL 
Database 
Name

• SQL server: the ODBC DSN name
• Oracle: the entry in tnsnames.ora
• DB2: the dbname

SQL User The user that Service Manager should connect to your 
Database with.

SQL 
Password

The password for the user that Service Manager should use 
to connect to your database with.

You must change the Service Manager service name if you are 
installing multiple instances of Service Manager server on the 
same machine. You must provide each Service Manager server 
instance with a unique service name.

Uploading the demo data also uploads the out-of-box 7.00 
applications. You will want to install these if you are not upgrading 
from ServiceCenter.
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The -language parameter sets the default code page to be used when 
exporting or importing data to or from external data sources. 

Follow these steps to change the default language:

1 Using a text editor, open the Service Manager initialization file from the 
Service Manager RUN directory.

2 Look for the language: parameter, and replace the ISO-code for English 
with a new language code.

3 Save the changes and close the file.

For a list of supported languages, refer to the Compatibility Matrix on the 
Customer Support web site. The HP Support matrices require that you 
register as an HP Passport user and sign in.

To register for an HP Passport ID, go to: 
http://h20229.www2.hp.com/passport-registration.html.

If you already have an HP Passport account, go to: 
http://support.openview.hp.com/sc/support_matrices.jsp.
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4 Client Installation
You can only install an HP Service Manager Windows client on a Windows 
workstation. You can support clients running on other operating systems by 
installing the Service Manager web tier. This section contains information 
about installation requirements and how to install the Windows client.

Topics in this section include:

• Installing the Service Manager Windows Client on page 64

• Installing a Shared Service Manager Client on page 70

• Uninstalling the Service Manager Client or its Components on page 72
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Installing the Service Manager Windows Client

You must have local administrator privileges to install the Service Manager 
client. 

The Windows client requires that the workspace and configuration folders are 
writable. The client workspace and configuration information is stored, by 
default, in the following directory:  
C:\Documents and Settings\user_name\Service Manager.

Upgrading the Windows Client

You cannot upgrade previous Service Manager clients to the Service Manager 
7.00 Windows client. You must install the Service Manager 7.00 Windows 
client in a new folder. HP recommends that you remove previous Service 
Manager clients, but it is not required.

Make a backup of any customized Help files you have created for your Service 
Manager clients. The installer for the Service Manager 7.00 Windows client 
overwrites any customized help from prior clients.
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Installation Requirements

Service Manager Client Setup

The Service Manager Windows client setup displays in the same language as 
the operating system.

Follow these steps to install the Service Manager Windows client:

1 Log in to the Windows server as a user with local administrator privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

3 Click Install Windows Client.

4 The Service Manager Client Setup wizard opens.

5 Click Next to read and accept the licensing agreement.

Table 1 Windows client installation requirements

Requirement Minimum Recommended

OS Windows 2000 Windows 2000 or XP

CPU Pentium III 650Mhz Pentium IV or Celeron 2.4 Ghz

RAM 256 MB 384 MB

HD 150 MB Help Server installed 150 MB with Help Server installed
300 MB with documentation installed

Resolution 800 x 600 (16 colors) 1280 x 1024 (256 colors)

Network 100 Megabit 100+ Megabit

Login account Local administrator account Local administrator account
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6 Select the I accept the terms in the License Agreement option.

The Next button becomes active.

The Select Installation Folder page opens.

7 Do one of the following:

a Click Next to accept the default installation folder.

The default installation folder is: 
C:\Program Files\HP\Service Manager 7.00\Client

b Click Browse to choose a different installation location.

8 Click Next to select the client features you would like to install. 

9 Click Next to prepare the installation process.

The Summary page opens.

10 Click Install to begin copying the installation files.

You can stop the installation by clicking Cancel.

The Completing the Service Manager Client Setup wizard dialog box 
opens when the installation is complete.

11 Click Finish to exit the Setup wizard.

The client installation is complete. 

12 Close the browser window, or click the next item you want to install.

Defining a New Client Connection

The first time you access the client, the Connections window opens letting you 
define a connection to a Service Manager host server. You can add and save 
multiple connection settings from the Connections window.

You must set your connection to an active server process. By default, these are 
are follows. 

• A client listener on ports 13080 (http) and 13443 (https/SSL) for HTTP 
clients, including Windows, web, and SOAP-API.

• A special listener on port 12690 for SCAuto
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If your server setup does not use the default settings, you must set the client 
to connect to the server.

Follow these steps to define a new client connection:

1 From the Windows main menu, click Start > Programs > Service Manager 
Client > Service Manager Client.

The Connections window opens.

2 Click New.

The Connections window displays a new node in the Connections pane.

3 Type or select the connection parameters.

Table 2 Windows client connection parameters

Parameter Default option Description

Name New_configuration The name of this configuration.

User name User name of the 
Windows user 
currently logged on.

The name that you use to log in to the server.

Password blank The password that you use to log in to the 
server.

Remember my 
password

False An option for the system store your password.

Automatically login False An option to log in automatically when you 
start the Service Manager client.

Server host name localhost The name of the server that hosts the Service 
Manager service.

Server port number 13080 The port number that your computer uses to 
connect with the server.

Language blank The language to use for this session (can differ 
from the language set on the computer).

Connection identified 
by a color

blank An option to change the background color of 
your connection.
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4 Click Advanced to set other connection options.

The advanced features are optional.

5 Click OK to add advanced features.

6 Click Apply to add the connection.

7 To add additional connections, repeat step 2 through step 6.

Table 3 Windows client advanced connection parameters

Parameter Description

Compress  
SOAP messages

An option that compresses SOAP messages using GNU zip (gzip) 
encoding. This can reduce the amount of data transmittal to and from the 
server.

Use SSL  
Encryption

An option that uses a Secure Socket Layer (SSL) encryption tool to protect 
your data when transmitting it over the network.

Trace SOAP  
traffic

An option that logs SOAP messages for debugging.

You must define a valid CA certificates file to enable SSL 
encryption. A sample CA certificate file called cacerts is included 
with the client installation. The default location of the cacerts file 
for a windows installation is: 
C:\Program Files\HP\Service Manager 7.00\Client\ 
plugins\com.hp.ov.sm.client.common_7.00

For additional information about configuring the Windows client, 
see the Service Manager Help.
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Connecting to a Service Manager server

You can connect to multiple servers from one Service Manager client. Each 
connection opens in its own window.

Follow these steps to connect to a Service Manager server:

1 From the Windows main menu, click Start > Programs > Service Manager 
Client > Service Manager Client.

The Connections window opens.

2 Do one of the following:

• Double-click a connection.

• Click a connection and then click Connect.
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Installing a Shared Service Manager Client

You can install the Service Manager client on a network share and have 
multiple users run from the shared client installation. In a shared client 
configuration, you can configure each user to have their own local settings or 
force users to use common settings. The Service Manager server tracks each 
client connection separately regardless of its source.

Follow these steps to install a shared instance of the Service Manager client:

1 Install the Service Manager client on a network server. 

For more information, see Installing the Service Manager Windows Client 
on page 64.

2 Create a Windows network share to the folder where you installed the 
Service Manager client, and grant users access to the network share. For 
example:

\\my_server\Service Manager Client

For more information, refer to the Windows online help. 

3 Log in to the computer system of each user who will use the shared client.

4 Map the network share to a drive letter on the local system. For example:

5 Create a Windows shortcut to the ServiceManager.exe file in the 
network share. For example:

F:\ServiceManager.exe

By default, all users share common client settings. If you want each user 
to have their own local client settings, continue to the next step.

6 Modify the target properties of the Windows shortcut to add the following 
information after the executable name.

-data %USERPROFILE%\Service Manager\

Table 4 Example Windows network drive mapping

Drive letter Mapped to

F: \\my_server\Service Manager Client
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The -data parameter allows you to specify a path where you want to store 
client settings. The example path above places a Service Manager folder 
in the Document and Settings folder of the currently logged in user.

If your path name includes spaces, you must enclose the path in 
double quotation marks. For example:

F:\ServiceManager.exe -data "%USERPROFILE%\HP 
Service Manager\workspace"
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Uninstalling the Service Manager Client or its 
Components

You can uninstall the Service Manager client using Windows Add/Remove 
Programs.

Follow these steps to uninstall the Service Manager client or components:

1 From the Windows main menu, click Start > Settings > Control Panel > Add/
Remove Programs.

The Add/Remove Programs window opens.

2 Scroll to Service Manager Client and click Remove.

A message prompts you to verify removing the program.

3 Click Yes.

The uninstall process takes several minutes. Additional messages indicate 
the progress of the uninstall.

When you complete the uninstall, you return to the Add/Remove 
Programs dialog box.

4 Click Close.

The client uninstall process intentionally preserves your client 
configuration settings. You must manually remove these files if you 
are completely uninstalling Service Manager from your system HP 
recommends you delete the entire client installation folder and the 
local writable workspace and configuration folder if you do not want 
to preserve any existing client settings.
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5 Web Tier Installation
The web tier installation allows clients to use a web interface to access the 
HP  Service Manager server.

Topics in this section include:

• Web Tier Architecture on page 74

• Browser Requirements for the Web Client on page 75

• Installing the Web Tier on page 76

• Accessing Service Manager from the Web Client on page 85

• Using the Telephony Web Client on page 88
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Web Tier Architecture

The Service Manager web tier uses both a web server and a web application 
server to allow access Service Manager forms through a web browser. The web 
server handles incoming HTTP requests while the web application server 
runs the Java and JSP necessary for connecting to Service Manager.

You install the web tier on Windows or Unix platforms by deploying the 
webtier-7.00.war file to your web application server. Some web application 
servers also require you install the Sun J2SE Java Development Kit (JDK).

Some web application servers such as Tomcat and WebSphere include built in 
web servers.
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Browser Requirements for the Web Client

In order for users to access the web client through a browser, the following 
settings and options must be enabled:

• Enable Cookies

• Enable Java

• Enable JavaScript

• Enable pop-ups. You can add the Service Manager server URL to the 
pop-up exception list.

To display the workflow graphical view, install one of the following Java 
components:

Table 1 Web client browser requirements

Operating System Java component to install

Windows XP One of the following:
• Microsoft Java Virtual Machine (JVM) 

plug-in
• Sun Java Runtime Environment (JRE) 

All other operating systems Sun Java Runtime Environment (JRE)
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Installing the Web Tier

To install the Service Manager web tier you must complete the following 
tasks:

Task 1: Install Apache.

See Installing Apache 2.0.X on page 77.

Task 2: Deploy the Service Manager web tier to your web application server.

See Deploying the Service Manager Web Tier on page 79.

Task 3: Install endorsed JAR files if needed by your web application server.

See Installing Endorsed JAR Files on page 80.

Task 4: Set your web application server memory settings for your production environment.

See Setting the Web Application Server Heap Size on page 81.

Task 5: Set global web client preferences in the web.xml file

See Setting Web Client Preferences from the web.xml Configuration File on 
page 82.
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Installing Apache 2.0.X

Follow these steps to install Apache 2.0.X:

1 Locate the httpd.conf file in the following directory: 
C:\Program Files\Apache Group\Apache2\Conf\httpd.conf

2 At end of the httpd.conf file, add the following two lines:

### Tomcat 5.0 Connector ####
include  
"C:\Program Files\Apache Group\Apache2\conf\mod_jk.conf"

3 Call Support to get the SAM-M0V-PJ12.zip (in zipped format). The zip 
will contain the following files:

workers.properties (size 6 KB unzipped) 
mod_jk.conf (size 4 KB unzipped) 
mod_jk.dll (size 136 KB unzipped)

4 Copy workers.properties and mod_jk.conf to the following location.

C:\Program Files\Apache Group\Apache2\Conf

5 Edit the workers.properties file to ensure that these parameters 
exist.

— [uri:/sc/servlet/*] 
info=Prefix mapping

— [uri:/sc/*.jsp] 
info=Extension mapping

— [uri:/sc/*.do] 
info=Extension mapping

— [uri:/sc/attachments/*] 
info=Extension mapping

— [uri:/sc/cwc/nav.menu] 
info=Extension mapping
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6 The mod_jk.conf file may require editing to accommodate different 
paths. For reference, the content of the file is as follows:

Alias/sc "C:/Program Files/Apache Software Foundation/
Tomcat 5.0/webapps/sc"

<Directory "C:/Program Files/Apache Software Foundation/
Tomcat 5.0/webapps/sc">

allowOverride None
Options None
Order allow,deny
Allow from all

</Directory>
#
# The following line prohibits users from directly  
# accessing WEB-INF
#
<Location "/sc/WEB-INF/">

AllowOverride None
deny from all

</Location>
#
# Use Directory too. On Windows, Location doesn't work  
# unless case matches
#
<Directory "C:/Program Files/Apache Software Foundation/
Tomcat 5.0/webapps/sc/WEB-INF/">

AllowOverride None
deny from all

</Directory>
#
# The following line prohibits users from directly  
# accessing META-INF
#
<Location "/sc/META-INF/">

AllowOverride None
deny from all

</Location>
#
# Use Directory too. On Windows, Location doesn't work  
# unless case matches
#
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<Directory "C:/Program Files/Apache Software Foundation/
Tomcat 5.0/webapps/sc/META-INF/">

AllowOverride None
deny from all

</Directory>

7 Copy the mod_jk.dll file into the following directory:

C:\Program Files\Apache Group\Apache2\modules directory.

Deploying the Service Manager Web Tier

The Service Manager web tier contains a J2EE-compliant web application 
that runs on your web application server. Each web application server has its 
own method of deploying web applications. See your web application server 
documentation for specific instructions on deploying a web application.

The following table provides a summary of deployment methods required.

For example, use the following steps to deploy the webtier-7.00.war file on 
Tomcat.

1 Log in to the server as a user with local administrator privileges.

2 Stop the Tomcat Web application server.

3 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

Table 2 Web tier deployment methods

Web application 
server Deployment method

Apache Tomcat Copy the webtier-7.00.war file to the webapps 
folder and start the web application server.

BEA WebLogic Open the administration console and install the web 
application from the webtier-7.00.war file.

IBM WebSphere Open the administration console and install the web 
application from the webtier-7.00.war file.
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If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

4 Click Download Service Manager Web Tier. The File Download prompt opens.

5 Click Save. The Save As dialog box opens.

6 Save the file to your Tomcat webapps directory. For example, C:\Program 
Files\Apache Software Foundation\Tomcat 5.0\webapps)

7 Start the Tomcat server.

Tomcat automatically opens the webtier-7.00.war file and creates the sc 
folders and files you need. 

Installing Endorsed JAR Files

Depending on the web application server you use, you may need to install 
several endorsed JAR files to allow the Service Manager web tier to function 
properly. These files enable certain features such as SOAP over HTTP and 
Fast Infoset encoding. 

This table lists the requirements for endorsed JAR files by each supported 
web application server.

If the sc directory was not created when the Tomcat server started, check the 
log files and contact support with the information found therein.

Table 3 Web application servers that require endorsed JAR files

Web application  
server

Install 
endorsed 
JAR files? Place in

Apache Tomcat Yes $TOMCAT_HOME/common/endorsed

IBM WebSphere Yes $WAS_HOME/java/jre/lib/endorsed

BEA WebLogic No n/a
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The required JAR files include:

• dom-jwsdp-1.6.jar 

• jai_imageio-1.0.jar 

• jaxp-api-jwsdp-1.6.jar 

• sax-jwsdp-1.6.jar 

• xalan-jwsdp-1.6.jar 

• xercesImpl-jwsdp-1.6.jar

Follow these steps to install the endorsed JAR files:

1 Copy all JAR files from the following folder of the Service Manager 
installation DVD: 

Redistributables\Java\Endorsed

2 Add the files to the endorsed folder of your web application server. 

Be sure to replace any files currently in the endorsed folder with the files 
from the Service Manager installation DVD.

Setting the Web Application Server Heap Size

The web application server heap size directly determines how many 
connections each web application server can handle. Most application servers 
require a heap size of at least 256 MB for optimal performance. If you 
experience poor performance from your web client connections, try increasing 
the web application server heap size. See your web application server 
documentation for instructions on setting the heap size.

If you do not already have an endorsed folder for your web 
application server, you must create one to install the endorsed JAR 
files.
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Configuring the Web Server to Work with Service Manager

IIS

Edit the workers.properties.minimal (IIS 5) or workers2.properties (IIS 6.2) 
file to include the following 5 parameters:

[uri:/sm/servlet/*] 
info=Prefix mapping

[uri:/sm/*.jsp] 
info=Extension mapping

[uri:/sm/*.do] 
info=Extension mapping

[uri:/sm/attachments/*] 
info=Extension mapping

[uri:/sm/cwc/nav.menu] 
info=Extension mapping

Setting Web Client Preferences from the web.xml Configuration File

You can define global web client preferences from the web.xml file on the web 
tier server. The settings you define in this file determine the client preferences 
for all web clients. See the Service Manager online help for a complete list and 
more detailed explanation of each parameter

Follow these steps to set client preferences from the web.xml file:

1 Open the webtier-7.00.war file in an archive management program.

You can download these files from the Service Manager installation DVD.

2 Extract the web.xml file from the archive to your local system.

3 Open the web.xml file in a text editor.

4 Add or edit the preferences in the file.

Extract this file into its default path of WEB-INF\ so that you can 
preserve the path information when you archive it again.
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At a minimum, you must set the serverHost and serverPort parameters.

For a list of the most commonly set web parameters, see Commonly Set 
Web Parameters on page 84.

5 Save the file.

6 Add the updated web.xml file back into the webtier-7.00.war archive.

Web clients will now use the client preferences you defined in the 
web.xml file when you deploy the webtier-7.00.war to the web tier.

Web Tier Log Files

The Service Manager web tier writes logs files to the default log file and 
location used by your web application server. see your web application server 
documentation for the name and location of the log file.

<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE web-app PUBLIC "-//Sun Microsystems, 
Inc.//DTD Web Application 2.2//EN" "http://
java.sun.com/j2ee/dtds/web-app_2_2.dtd">

<web-app>

<display-name>Service Manager</display-name>

<description>Service Manager</description>

...

<init-param>

<param-name>serverHost</param-name>

<param-value>localhost</param-value>

</init-param>

<init-param>

Set the host

Set the port

The web.xml file must include the WEB-INF\ path.
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Commonly Set Web Parameters

Table 4 Commonly set web tier parameters 

Parameter
Default  
value Description

cacerts WEB-INF This parameter lists the path to the CA certificates required 
for SSL support.

compress_soap false This parameter specifies if you want to use data compression 
between web clients and the Service Manager web tier.

helpServerHost localhost This parameter specifies the name of the Service Manager 
Help Server.

helpServerPort 80 This parameter specifies the communications port number 
to which the Service Manager Help Server listens.

refreshMessages false This parameter determines whether the browser checks for 
new messages from the application server.

refresh 
MessagesInterval

15000 This parameter determines how often (in milliseconds) the 
browser checks for new messages from the application 
server.

serverHost localhost This parameter specifies the name of the Service Manager 
host server.

serverPort 13080 This parameter specifies the communications port number 
to which the Service Manager server listens.

ssl false This parameter enables the web client to encrypt 
communications using the server’s demonstration 
certificate.

viewactivenotes false This parameter determines whether you see a pop-up 
message when the server sends a message. 
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Accessing Service Manager from the Web Client

Use the following URLs to access the Service Manager from the web tier.

• The address for the standard web client is:

http://<server>:<port>/sm/index.do

The address for employee self-service web client is:

http://<server>:<port>/sm/ess.do

The address for the accessible web client is:

http://<server>:<port>/sm/accessible.do

This address turns off record list mode and the classic menu, which do not 
conform to accessibility requirements.

The address for the accessible employee self-service web client is:

http://<server>:<port>/sm/accessible_ess.do

For <server>, type the name of the web server running the web 
tier. For <port>, type the communications port number used to 
connect to the web tier.

Tip:

You do not need to specify the communications port in the web tier URL if you 
use the default web server port (port 80). see your web server documentation 
for instructions on setting the communications port.
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Web Client Computer Telephony Integration (CTI)

The web client can support connections from Computer Telephony 
Intergration (CTI) applications. The Web client CTI implementation uses the 
ServiceCenter Event Services application to open or update records.

Follow these steps to set up and use CTI:

1 Set up your web browser. 

See Setting Web Client Preferences from the web.xml Configuration File 
on page 82.

2 Install a JRE. 

See Installing the JRE on page 87.

3 Install the CTI applet.

See Installing the CTI Applet on page 87.

4 Connect to the web client to recieve calls.

See Taking a Call with the Telephony Web Client on page 89.

Setting the Web Browser Requirements

Enable the following settings and options to use CTI with a web client:

• Cookies

• Java

• JavaScript

• Pop-ups. (Add the ServiceCenter server URL to the pop-up exception list.)
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Installing the JRE

You must install a Java Runtime Environment (JRE) on each web client 
system to run the CTI applet. See your Web browser documentation to 
determine a compatible JRE version.

For example, you can follow these steps to install the Sun J2SE JRE, which 
you can use with Internet Explorer or Mozilla:

1 Go to Sun java web site: http://java.sun.com/j2se/1.4.2/download.html.

2 Click the Download J2SE JRE link.

3 Accept the license agreement.

4 Navigate to your operating system (for example, Windows), and download 
the latest JRE for your operating system.

Installing the CTI Applet

You must perform a one-time installation of the CTI applet on each web client 
system so the web client can accept Service Manager system events from a 
CTI application.

Follow these steps to install the CTI applet:

1 Log in to the web client system with a local administrator account.

2 Close all other Service Manager clients and web browser windows.

3 Open a web browser and navigate to the telephony web tier URL:

Table 5 Browser JRE requirements for CTI support

Operating System Java component to install

Windows XP One of the following:
• Microsoft Java Virtual Machine (JVM) plug-in
• Sun's Java Runtime Environment (JRE) 

Other operating 
systems

Sun Java Runtime Environment (JRE)

The applet installation requires a local administrator account.
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http://<server>:<port>/sc/index.do?telephonyuser=1

For <server>, type the name of the web server running the web tier. For 
<port>, type the communications port number used to connect to the web 
tier.

4 If the web client system has a properly installed JRE, then the web 
browser prompts the user to install the CTI applet:

5 Click the appropriate action on your browser to accept the applet (for 
example, Run or OK).

6 Close and restart the web browser.

Using the Telephony Web Client

The telephony web client requires a CTI application and the Event Services 
application within Service Manager.

Accessing CTI from the Web Client

You can use the following URLs to access the telephony portions of the web 
client.

• The address for the standard telephony web client is:

http://<server>:<port>/sm/index.do?telephonyuser=1

• The address for the accessible telephony web client is:

http://<server>:<port>/sm/accessible.do?telephonyuser=1

This address turns off record list mode and the classic menu, which do not 
conform to accessibility requirements.

For <server>, type the name of the web server running the web tier. For 
<port>, type the communications port number used to connect to the web tier.

The telephony applet does not apply to the self-service portions of Service 
Manager.

Tip:

You do not need to specify the communications port in the web tier URL if you 
use the default web server port (port 80). see your web server documentation 
for instructions on setting the communications port.
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Taking a Call with the Telephony Web Client

When an event comes from a CTI application, the telephony web client 
prompts users to save their current work. 

Save your current work and then click Yes to receive the incoming call (or 
other event).
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6 Help Server Installation
You must install the HP Service Manager Help Server on a Windows system. 
This section contains information about installation requirements and how to 
install the Help Server. For information about starting and stopping the Help 
Server, refer to the Service Manager online help.

Topics in this section include:

• Overview of the Service Manager Help Server on page 92

• Installing the Help Server on Windows on page 94

• Accessing the Help Server on page 97
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Overview of the Service Manager Help Server

The Service Manager Help Server provides a centralized location to access 
and store all online help files. The Service Manager Help Server includes an 
integrated web server that allows end users to access documentation from 
either the Windows or web clients as well as directly from a web browser.

Upgrading the Help Server

You cannot upgrade previous Help Servers to the Service Manager 7.00 Help 
Server. You must install the Service Manager 7.00 Help Server in a new folder 
or on a different system than your previous Help Server. HP recommends that 
you remove previous Help Servers, but it is not required.

Installation Considerations

Installing the Service Manager Help Server enables you to:

• Provide your users with an easily updatable help source.

• Deploy tailored versions of Service Manager documentation. You can edit 
the online help stored on the Help Server and deploy it with the integrated 
web server. All clients that connect to the Help Server automatically see 
the customized online help files.

Known Issues

The Service Manager Help Server has the following known issues:

• The Help Server can only deploy documentation in the existing plug-ins. 
You must add or edit topics in the existing plug-ins.

To test the Help Server from the server machine, use a direct browser 
connection to:

http://<helpserverhost>:<helpserverport>/help/

Make a backup of any customized Help files you have created for your Help 
Servers. The installer for the Service Manager 7.00 Help Server overwrites 
any customized help from prior Help Servers.
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For <helpserverport>, type the name or IP address of the Help Server you 
want to connect to.

For <helpserverport>, type the communications port used to connect to the 
Help Server. You may omit the port number if you use the default port 80 
HTML port.
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Installing the Help Server on Windows

After installing the Help Server, you can customize the server settings in the 
Help Server Configuration Wizard.

Installation Requirements

• Windows 2000 or Windows 2003

• The most current Windows updates on your operating system

• 240 MB disk space

• 256 MB RAM minimum recommended

— For testing purposes, 128 MB RAM is sufficient
— For production purposes, RAM is based on the expected user load

• A free communications port to listen for HTTP connections requests. The 
default communications port is 8083.

• One of the following Java components:

Service Manager Help Server Setup

Follow these steps to install the Service Manager Help Server:

1 Log in to the Windows server as a user with local administrator privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

Table 1 Help server installation requirements

Operating system Java component to install

Windows XP One of the following:
• Microsoft Java Virtual Machine (JVM) plug-in
• Sun Java Runtime Environment (JRE) 

All other OS Sun Java Runtime Environment (JRE)
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If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

3 Click Install Help Server.

The Service Manager Help Server Setup wizard opens.

4 Click Next to read and accept the licensing agreement.

5 Select the I accept the terms in the License Agreement option.

The Next button becomes active.

6 Click Next to continue.

The Select Installation Folder page opens.

7 Type or select the path where you want to install the Help Server.

8 Click Next to continue.

The Ready to Install page opens.

9 Click Install.

The wizard installs the Help Server on the system.

10 Click Finish.

The Configure HP Help Server wizard opens.

11 Click Next to continue.

The Service Manager Help Server Configuration page opens.
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12 Do one of the following:

a Click Skip to use the default configuration settings.

b Update the following parameters as needed.

13 Click Next to continue.

The Service Manager Help Server Configuration page opens.

14 Select the Install Windows Service option.

15 Click Finish.

The wizard configures the Help Server and installs the Windows service.

Table 2 Help server configuration parameters

Parameter
Default 
value Description

Server port 8083 This parameter specifies the 
communications port to which you want the 
Help Server to listen for HTTP requests.

Windows 
Service  
Name

Service 
Manager 
Help Server

This parameter specifies the name of the 
Windows service you want the Help Server 
to use.
96 Chapter 6



Accessing the Help Server

You can access the Help Server from the following interfaces:

• Windows client

• Web client

• Web browser

Accessing the Help Server from the Windows Client

To have Windows clients display online help from the Help Server, you must 
configure the Windows client preferences and define the Help Server host 
name and communications port. 

Follow these steps to configure a Windows client to display online help from 
the Help Server:

1 Log in to the Windows client.

2 Click Window > Preferences.

The Preferences window opens.

3 Click the Help node to expand it.

4 Click Help Server.

5 Type the following information:

a Host name or IP address of the Help Server

b Communication port of the Help Server

6 Click OK.

The Windows client now displays the online help from the Help Server 
when the user clicks the Help icon or select Help > Help Contents.

This setting is saved with your client preferences and is captured by the 
Client Configuration utility so that you can easily deploy it to your Windows 
client users.
Help Server Installation 97



Accessing the Help Server from the Web Client

By default, web clients do not display online help. To have web clients display 
online help from the Help Server, you must configure the web client web.xml 
file and define the Help Server host name and communications port.

Follow these steps to configure a web client to display online help from the 
Help Server:

1 Log in to the server where you installed the web tier.

2 Open the web.xml file from the sm/WEB-INF folder of your application 
server installation.

3 Type the following information:

a sm.helpserverhost - Host name or IP address of the Help Server

b sm.helpserverport - Communication port of the Help Server

4 Save the web.xml file.

The web client displays the online help from the Help Server.

Accessing the Help Server from a Browser

You can view the online help from a Help Server by typing the following URL 
into a compatible web browser:

http://<helpserverhost>:<helpserverport>/help/

For <helpserverport>, type the name or IP address of the Help Server you 
want to connect to.

For <helpserverport>, type the communications port used to connect to the 
Help Server. You may omit the port number if you use the default port 80 
HTML port.
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7 Client Configuration Utility Installation
You can install the Service Manager Client Configuration Utility on a 
Windows system. This section contains information about installation 
requirements and how to install the Client Configuration Utility.

Topics in this section include:

• Overview of the Service Manager Client Configuration Utility on page 100

• Installing the Client Configuration Utility on Windows on page 102

• Customizing Images Used by the Windows Client on page 104

• Customizing the Windows Client on page 106
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Overview of the Service Manager Client Configuration 
Utility

The Service Manager Client Configuration Utility is an optional tailoring 
component that enables you to customize a Windows installation for deploying 
to end users. You can use the Client Configuration Utility to customize the 
Windows client before deploying it to the rest of your organization.

The Client Configuration Utility cannot push customizations changes to 
previously installed Windows clients. To change existing installations of the 
Windows client, you uninstall the existing client and reinstall using the 
customized files you create. 

The Client Configuration Utility only picks up changes made directly from the 
Windows client interface or within the utility itself. The Client Configuration 
Utility cannot pick up changes made directly to Windows client initialization 
files.

The Service Manager Client Configuration Utility changes the following 
Windows client settings:

• The splash screen image that Service Manager displays when users open 
the Windows client

• The name of provider listed for Service Manager — for example, 
Hewlett-Packard Development Company, L.P.

• The name of the Service Manager application - for example, Service 
Manager

• The location of application images and icons

• The location of the Help Server where Windows clients can access 
documentation

• The changes that an administrator saves within the Windows client 
interface prior to running the Client Configuration Utility, including:

— Default login options

— Which Connection dialog box configuration options to display

— The default connection configuration settings

— Help server configuration options
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Installation Considerations

You may want to use the Service Manager Client Configuration Utility for the 
following reasons:

• To deploy tailored versions of Windows clients. You can use the Client 
Configuration Utility to preconfigure Windows clients to use custom 
settings and images.

• To reduce the number of tailoring steps. When you use the Client 
Configuration Utility you are not required to tailor each Windows client 
individually.

Known Issues

The Service Manager Client Configuration Utility has the following known 
issues:

• You must customize images before you run the Client Configuration 
Utility. The Client Configuration Utility enables you to change the 
location of images but not to edit them directly.

• If you deploy a repackaged Windows client that has a predefined 
connection over SSL, then the Windows clients may display the connection 
error message “No trusted certificate found” if users install the 
customized client in a different path than the original client install. You 
can restore the client connection by providing the correct path to the CA 
certificate file in the client Preferences dialog box. 
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Installing the Client Configuration Utility on Windows

You install the Client Configuration Utility by running the installation 
executable on the installation DVD. After installation, you can customize the 
Windows client settings by using the Client Configuration Utility.

Installation Requirements

• Windows 2000, Windows XP Professional or Windows Vista

• The most current Windows updates on your operating system

• 70 MB disk space

• 256 MB RAM minimum recommended

— For testing purposes, 128 MB RAM is sufficient

— For production purposes, add RAM to match the expected user load

• Access to a Service Manager Windows client installation

Service Manager Client Configuration Utility Setup

Follow these steps to install the Service Manager Client Configuration Utility:

1 Log in to the Windows system as a user with local administrator 
privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

3 Click Install Client Configuration Utility.

The Service Manager Client Configuration Utility Setup wizard opens.

4 Click Next to read and accept the licensing agreement.
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5 Select the I accept the terms in the License Agreement option.

The Next button becomes active.

6 Click Next to continue.

The Select Installation Folder page opens.

7 Type or select the path where you want to install the Client Configuration 
Utility.

8 Click Next to continue.

The Ready to Install page opens.

9 Click Install.

The wizard installs the Client Configuration Utility on the system.

10 Click Finish.
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Customizing Images Used by the Windows Client

You can customize the images that Windows clients use by providing alternate 
versions of the images from a local folder or web server virtual directory

Image Editing Guidelines and Considerations

The following guidelines and considerations apply to customized images:

• All custom images must retain their original file name.

• All custom images must retain their original relative path from the 
icons/obj16 folder.

• You only need to save customized images in the branded/obj16 folder. If 
the Service Manager client does find updated images in the branded/
obj16 folder it uses the default images in the icons/obj16 folder.

• Providing custom images from a web server allows you to automatically 
update images without having to reinstall the Windows client.

Providing Custom Images from a Local Folder

You can use the following steps to provide custom images with the repackaged 
client. This image customization method increases the amount of hard disk 
space required to install the Service Manager Windows client as the custom 
images are installed in addition to the default images.

Follow these steps to customize images from a local folder:

1 Copy the images from the Service Manager client into a temporary folder.

The Service Manager client images are located in the following folder: 
C:\Program Files\HP\Service Manager 7.00\Client\plugins\ 
com.hp.ov.sm.client.eclipse.user_7.00\src\resources\icons
\obj16

2 Edit the images you want to customize in the temporary folder.

See Image Editing Guidelines and Considerations on page 104.

3 Delete any images that you do not customize from the temporary folder.

4 Run the Client Configuration Utility and select the local images option.
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The Client Configuration Utility creates the following new folder in the 
Service Manager client installation: 
C:\Program Files\HP\Service Manager 7.00\Client\plugins\ 
com.hp.ov.sm.client.eclipse.user_7.00\src\resources\icons
\branded\obj16

5 Copy your custom images to the branded\obj16 folder.

6 Repackage the client as a zip file or another distribution format of your 
choice.

Providing Custom Images from a Web Server Virtual Directory

You can use the following steps to provide custom images from a central web 
server. This image customization method does not increase the amount of 
hard disk required to install the Service Manager Windows client. In addition, 
any changes you make to images on a web server are automatically applied to 
Windows clients.

Follow these steps to customize images from web server virtual directory:

1 Create a virtual directory on your web server to store the custom images.

2 Copy the images from the Service Manager client into a temporary folder.

The Service Manager client images are located in the following folder: 
C:\Program Files\HP\Service Manager 7.00\Client\plugins\ 
com.hp.ov.sm.client.eclipse.user_7.00\src\resources\icons
\obj16

3 Edit the images you want to customize in the temporary folder.

See Image Editing Guidelines and Considerations on page 104.

4 Delete any images that you do not customize from the temporary folder.

5 Copy your custom images to the virtual directory on your web server.

6 Run the Client Configuration Utility and select the web server virtual 
directory option.

The Client Configuration Utility configures the Service Manager client to 
point to the URL of your web server virtual directory.

Tip:

You can copy the your custom images to the local folder while the 
Client Configuration Utility is open.
Client Configuration Utility Installation 105



Customizing the Windows Client

In order to use the Client Configuration Utility, you must have previously 
installed a Windows client. 

Follow these steps to create a custom Windows client:

1 Click Start > Programs > Service Manager Client Configuration Utility > Service 
Manager Client Configuration Utility.

The Client Configuration Utility opens.

2 Click Next to continue.

The Specify Service Manager Directory page opens.

3 Type or select the path to an existing installation of the Service Manager 
Windows client.

4 Click Next to continue.

The Change Startup Splash Image page opens.

5 Do one of the following:

• Click Skip to use the default splash image.

• Type or select the path to the splash screen image you want to use.

The default splash screen image is named splash.gif and is located in the 
following folder: 
C:\Program Files\HP\Service Manager 7.00\Client\plugins\ 
com.hp.ov.sm.client.eclipse.user_7.00\src\resources\icons
\obj16

Use the following guidelines to edit the splash screen image:

• The image must retain its original file name

• The image must be in the Windows bitmap (gif) file format

• The image should be approximately 500 wide by 600 pixels high. The 
Client Configuration Utility crops larger images to this size.

6 Click Next to continue.

The Replace Provider and Application Strings page opens.
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7 Do one of the following:

• Click Skip to use the default application text strings.

• Type the text strings you want to use for the following items:

8 Click Next to continue.

The Customize Where Service Manager Application Images are Located 
page opens.

9 Do one of the following:

• Use the default application images.

– No customization: Select this option to use the default images.

– Click Skip.

• Select the path to your customized Windows client images.

– Locally: The Client Configuration Utility creates a folder named 
\branded\obj16 where you can place customized images to 
override the default Windows client images.

– Remotely: Type the URL where the Windows client can access 
customized images.

See Customizing Images Used by the Windows Client on page 104 for 
more information.

10 Click Next to continue.

The Customize Default Login Options page opens.

Table 1 Provider and application settings

Field Type this information

Provider Type the company name you want to display in the Windows 
client interface. The default name is Hewlett-Packard 
Development Company, L.P.

Application Type the application name you want to display in the Windows 
client interface. The default name is Service Manager.
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11 Do one of the following:

• Click Skip if you do not want to create a default connection.

• Select whether to display the following options on Connections dialog 
box of your customized client.

• Type the following information about the default connection you want 
to create.

Table 2 Connection dialog configuration options

Field Description

Show the 
"Remember my 
password" option. 

Enabled by default. When disabled, the client’s 
Connections dialog box will not display the "Remember 
my password" check box option.

Show the server 
parameters. 

Enabled by default. When disabled, the client’s 
Connections dialog box will not display the "Use Login/
Password" and "Use Trusted Sign-on" radio buttons, or 
the "Server host name" and "Server port number". Also, 
the New and Delete buttons will be disabled.

Show the 
"Advanced" 
options page. 

Enabled by default. When disabled, the client’s 
Connections dialog box will not display the "Advanced" 
notebook tab. Additionally, the "Trace SOAP Traffic" 
feature will not be available.

Table 3 Default connection dialog configuration options 

Field Description

Hostname Type the network name or IP address of the Service 
Manager server to which you want the Windows client 
to connect.

Port Number Type the communications port on which the Service 
Manager server listens to client connection requests. 
The default communications port is 13080.
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• Click Next to continue.

The Use and Configure Help Server page opens.

12 Do one of the following:

• Click Skip if you do not want to provide online help from a Help Server.

• Select the Use Central Help Server option to establish a connection to a 
Help Server. Type the following Help Server information.

Compress 
Messages

Select true to enable message compression between the 
Windows client and the Service Manager server. Select 
false to have messages remain uncompressed.

Use SSL 
Connection

Select true to enable an SSL connection between the 
Windows client and the Service Manager server. Select 
false to use a standard connection.

CA Certificate 
Path

Type or select the local path to the CA certificate used 
by your SSL connection. Leave this entry blank if you 
are not using an SSL connection.

You can find a sample CA certificate file cacerts in the following 
path: 
C:\Program Files\HP\Service Manager 7.00\Client\ 
plugins\com.hp.commons_7.00\

Table 3 Default connection dialog configuration options (cont’d)

Field Description

Table 4 Help server configuration options

Field Description

Help Server 
Host

Type the network name of the Service Manager Help 
Server to which you want the Windows client to connect.

Help Server 
Port

Type the communications port on which the Service 
Manager Help Server listens to client connection requests. 
The default communications port is 80.
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• Click Next to continue.

The Client Configuration Utility page opens.

13 Click Exit.

The client has now been configured and may be zipped or otherwise 
packaged for distribution.

The Help Server host and port must be identical to the settings you 
configured with the Help Server configuration wizard. See Help 
Server Installation on page 91 for more information.
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8 Search Engine Installation
You can install the HP Service Manager Search Engine on a Windows or Unix 
server. This section contains information about installation requirements as 
well as how to install the and configure the Search Engine.

The Knowledge Management applications are installed with the regular 
server installation, however the Search Engine must be installed separately.

Topics in this section include:

• Installing the Service Manager Search Engine on page 112

• Installing the Search Engine by Using the Installation Wizard on 
page 113

• Installing the Search Engine by Using the Text-Based Installer on 
page 116

• Starting and Stopping the Search Engine on page 118

• Configuring the Search Engine on page 119

• Indexing Data with the Search Engine on page 121
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Installing the Service Manager Search Engine

There are two ways of installing the Service Manager Search Engine. You can 
install the Search Engine by using an installation wizard, or by using a 
text-based installer. After installing the Search Engine, you can configure the 
Search Engine settings.

Installation Requirements

• 512 MB RAM

• 4-6 GB disk space

• 800 MHz or higher processor

• 400 MB of space designated for/tmp (Unix) and \TEMP (Windows)

Kernel Resource Requirements for HP-UX

To run Knowledge Management on HP-UX, configure the following kernel 
parameters:

The Linux installer includes JVM, but for other operating systems, you install 
JVM in order to run the Search Engine installer. 

Table 1 Knowledge Management kernel resource requirements for 
HP-UX 

Value Setting

maxdsiz 1.9 GB (0x7B033000)

maxfiles 2048 KB

maxfiles_lim 2048 KB

maxssiz 160 MB (0xA000000)

max_thread_proc 1024

maxswapchunks 8192

maxtsiz 1 GB (0x40000000)
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Installing the Search Engine by Using the Installation Wizard

Follow these steps to install the Service Manager Search Engine by using the 
installation wizard:

1 Insert the Search Engine installation DVD into the appropriate drive of 
the server.

2 Start the Service Manager Search Engine installation wizard.

3 If you are installing on a Windows system that has auto-run enabled, the 
wizard starts automatically. If auto-run is disabled, you can manually 
start the wizard by using one of the following methods.

On Windows systems

• From the GUI, navigate to the DVD directory.

Double-click setupwin32.exe.

– From the command prompt:

– Type the following:

– D:\>setupjwin32

where D identifies the DVD drive. Substitute your DVD drive 
identifier.

maxuprc 512

maxusers 128

nkthread 1024

nproc 517

Table 1 Knowledge Management kernel resource requirements for 
HP-UX (cont’d)

Value Setting
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On Unix systems

For HP-UX, be sure that you have set the kernel configuration parameters 
described in Kernel Resource Requirements for HP-UX on page 112.

• From the GUI:

– Mount the DVD and navigate to the DVD directory.

– Double-click the executable script that matches your Unix system, 
for example, setupsolaris for Solaris systems or setupaix for 
AIX systems.

• From the command prompt:

– Mount the DVD, and change directories to the mount location. 

– Run the executable script that matches your Unix system, for 
example: ./setupsolaris for Solaris systems or ./setupaix 
for AIX systems

The Service Manager Search Engine Setup wizard opens.

4 Click Next to read and accept the licensing agreement.

5 Select the I accept the terms in the License Agreement option.

The Next button becomes active.

6 Click Next to provide the following installation parameters.

Table 2 Search engine installation parameters

Parameter Value

Hostname Server host name
If the Search Engine will be on a separate machine on a 
separate domain, use the fully qualified domain, for 
example, my.machine.mydomain.com.

Masterport The default is 9950.

Docserver Port  
(9920-9949)

The default is 9948.

Indexer Port  
(9960-9979)

The default is 9967.
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7 Click Next to provide the installation directory.

The default installation directory for Windows is: 
C:\Program Files\HP\Service Manager 7.00\Search Engine

If necessary, click Browse to choose a different location.

8 Click Next to review the installation summary information.

9 Click Install to begin copying the installation files.  
To stop the installation click Cancel.

The InstallShield Wizard opens a dialog box when the installation is 
complete.

10 If you are on a Unix system, run InstallConfiguration.sh, which is 
found in your <Search Engine install path>/directory.

11 Click Finish to exit the Wizard.

Record these settings, you will need them to configure Service 
Manager to communicate with the Search Engine.
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Installing the Search Engine by Using the Text-Based 
Installer

Follow these steps to install the Service Manager Search Engine using the 
text-based installer:

1 Insert the Search Engine installation DVD into the appropriate drive of 
the server.

2 Run the installer.

3 On Windows systems

Open the command prompt and type the following:

D:\>setupwin32 -console

where D identifies the DVD drive. Substitute your DVD drive identifier.

On Unix systems

a Mount the DVD and change directories to the mount location.

b Run the executable script that matches your Unix system, for 
example: ./setupsolaris -console for Solaris systems or ./
setupaix -console for AIX systems.

4 At the installation script prompt, type yes to agree to the license 
agreement.

5 At the installation script prompt, type the installation directory address 
where you want to install Service Manager.

The system takes several minutes to read the contents of the DVD, 
uncompress the files, and create a logs directory.

6 At the installation script prompt, type a host name, then press Enter.

7 At the installation script prompt, type a Masterport number, then press 
Enter. The default is 9950.

The system validates any directory name that you specify. If you 
specify an invalid directory, the installation generates an error 
message.

If the Search Engine will be on a separate domain, use the fully 
qualified domain, for example, mymachine.mydomain.com.
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8 At the installation script prompt, type a Docserver Port number 
(9920-9949), then press Enter. The default is 9948.

9 At the installation script prompt, type an Indexer Port number 
(9960-9979), then press Enter. The default is 9967.

10 The server installation completes.

11 If you are on a Unix system, run InstallConfiguration.sh, which is 
found in your <Search Engine install path>/directory.

Record these settings, you will need them to configure Service 
Manager to communicate with the Search Engine.
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Starting and Stopping the Search Engine

On Windows Systems

The installer creates a service named KMSearch. Use it to start and stop the 
Search Engine. This service starts automatically after installation.

On Unix Systems

Add the following to the sm.ini file:

For HP-UX

plugin0:libkmplugin.sl

For all other versions of Unix

plugin0:libkmplugin.so

There are two executable scripts in your installation folder.

Run the k2adminstart.sh executable script file to start the index service for 
your Search Engine.

Table 3 Search engine start scripts for Unix systems

Name Purpose

k2adminstart.sh Starts the search engine and index service 

k2adminstop.sh Stops the search engine and index service 
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Configuring the Search Engine

Before you can use the Search Engine, you must set up connectivity, and then 
index the Search Engine.

Connecting to the Search Engine

Follow these steps to connect to the Search Engine:

1 Log in with a user with the KM ADMIN profile.

2 Open Services > Knowledge Management > Administration > Environment.

3 To Assign the Default Knowledge View Group to all operators, select the check 
box.

4 Specify the Host Name of Search Server. This must be identical to the host 
name you indicated when installing the server.

5 You can confirm that you have the correct information by looking in the 
configuration file at C:\Program Files\HP\Service Manager 
7.00\Search Engine\KMSearch.cfg.

6 Click Verify Server to verify connectivity to the Search Engine.

7 Specify the Mapped drive for Style files. The path is default is C:\Program 
Files\HP\Service Manager 7.00\Search Engine\data\stylesets.

8 Click Verify Path to verify that your path and map settings are correct.

9 Make sure that both the Search Engine and Service Manager server have 
read and write privileges in the stylesets folder.

10 Specify the Search Engine administration port number. This must be identical 
to the port number you indicated when installing the server. If you did not 
change the default port number, use the default given in the field.

If the Search Engine is installed on a separate machine, you will 
need to share the stylesets folder from the Search Engine to the 
Service Manager server. Use the share name and path for this 
setting so that the style files path in the environment form is set to 
the stylesets folder. 
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11 Specify the Search Engine indexer port number. This must be identical to the 
port number you indicated when installing the server. If you did not 
change the default port number, use the default given in the field.

12 Specify the Search Engine search port number. This must be identical to the 
port number you indicated when installing the server. If you did not 
change the default port number, use the default given in the field.

13 Specify the Max number of Documents returned from a search.

14 Specify the Default expiration period. The time limit specified here will be 
over-ridden if the user specifies expiration when they were creating a 
document by using the Contribute New Document function.

15 Specify the Style text for search results. Use this style sheet to control the 
appearance of the information the search returns. This is similar to an 
HTML css stylesheet.

16 Log out of Service Manager, and log back in again.
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Indexing Data with the Search Engine

Certain actions require a full reindex. These actions include the following:

• Initial setup (no indexes exist)

• Changing any value on the Type Information tab or the Field Definitions 
tab

You may also want to do a full reindex if:

• There are a large number of changes or new documents

• Search performance is becoming sluggish

As updates are applied to the index, they are added in as incremental index 
files. If you have a knowledge base that has had many changes applied, these 
incremental index files can slow the Search Engine down since it must 
perform your query on each one. A full reindex builds a new clean index that 
performs better, similar to defragmenting a hard-drive. Doing a full reindex on 
a large knowledge base can have a significant impact on system resources 
because it removes all changes for the knowledge base from the change cache.

Follow these steps to index data with the Search Engine:

1 Log in with a user with the KM ADMIN profile.

2 Open Services > Knowledge Management > Administration > Manage 
KnowledgeBases.

3 Click Search to bring up a list of knowledge bases.

4 For each knowledge base, check that the information is correct, and click 
Full Reindex. Refer to the field help for descriptions of each field.

5 If the index does not exist, it will be created. If it does exist, it will be 
deleted and recreated. The Docs field will not be blank after an index has 
been created.

After the Indexes have been created, users will be able to access the indexed 
documents the next time they log in.

You can only reindex or get status for your knowledge base if the Search 
Engine has been properly configured on the environment page. A message box 
will notify you if the Search Engine cannot be found.
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A Legacy Integrations
Using legacy integrations with the Service Manager server requires you to set 
up a read-only legacy ServiceCenter listener. A legacy integration is any 
integration that depends on SCCL32 or the ServiceCenter ODBC driver. 
These include Connect-It, Get-It, and Crystal Reports.

This appendix provides information on how to set up a legacy listener and 
connect to Service Manager, as well as how to set up the ServiceCenter ODBC 
driver. 

Topics in this appendix include:

• Overview on page 124

• Editing the sc.ini File on page 125

• Installing the Windows Service on page 126

• Starting a Legacy Listener on page 127

• Installing the ODBC Driver on page 128

• Configuring the ODBC Driver on page 129
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Overview

You will need to complete the following tasks in order to connect to Service 
Manager using SCCL32 or the legacy ServiceCenter ODBC driver. 

Task 1: Editing the sc.ini File on page 125

Task 2: Installing the Windows Service on page 126

Task 3: Starting a Legacy Listener on page 127 (Windows servers only)

Task 4: Installing the ODBC Driver on page 128

Task 5: Configuring the ODBC Driver on page 129

While the server runs on both Windows or Unix platforms. The ODBC driver 
runs only on Windows. 
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Editing the sc.ini File

The out-of-box server sc.ini file is configured to connect to the Demo 
Database. To connect to another RDBMS, edit the parameters in sc.ini. 
Windows users also need to add the ntservice parameter to the sc.ini file. 
This parameter provides the name used to identify the Windows service. 

Follow these steps to edit the sc.ini file:

1 Log in to the Service Manager server with an administrator account.

2 Open a command prompt and navigate to  
<Service Manager 7.00 installation path>\Server\ 
LegacyIntegration\RUN. 

3 Open the file sc.ini with a text editor.

4 To connect to your Service Manager RDBMS, add the database 
connectivity settings. These match the settings you used in Database 
Preparation on page 21.

5 Windows users only: Add the following parameter on its own line. 
ntservice:<Service Manager Legacy Readonly Service Name>

6 Save the file and exit. 

Unix users proceed to Starting a Legacy Listener on page 127.

Windows users continue with the next section, Installing the Windows 
Service.
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Installing the Windows Service

You can create a separate Windows service to use with the legacy ODBC 
driver. You can manually install a ServiceCenter Windows service on any 
machine where you have already installed Service Manager server.

Follow these steps to install the Windows service:

1 Log in to the Windows server as a user with local administrator privileges.

2 Open a command prompt and navigate to  
<Service Manager 7.00 installation path>\Server\ 
LegacyIntegration\RUN. 

3 Type scservic -install.

This command creates a Windows service with the name specified by the 
ntservice parameter in the sc.ini file.

Uninstalling the Windows Service

You can manually remove the Windows service on any machine where you 
have already installed Service Manager server.

Follow these steps to uninstall the Windows service:

1 Log in to the Service Manager server with an administrator account.

2 Open a command prompt and navigate to  
<Service Manager 7.00 installation path>\Server\ 
LegacyIntegration\RUN. 

3 Type scservic -uninstall.

This command removes the Windows service with the name specified by the 
ntservice parameter in the sc.ini file.
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Starting a Legacy Listener

You can start a read-only ServiceCenter listener in the background. Since this 
is not an instance of Service Manager it will not show up in your System 
Status window. 

Unix 

Follow these steps to start a listener for your legacy integration on Unix 
servers.

1 Navigate to C:\Program Files\HP\Service Manager 7.00\Server\ 
LegacyIntegration\RUN

2 Run the scstart script.

Windows

Follow these steps to start a listener for your legacy integration on Windows 
servers.

1 In Windows, open Start > Control Panel > Administrative 
Tools > Services. 

2 Select the service you installed in Installing the Windows Service on 
page 126, and click Start.

If you prefer, you can start the listener as an application instead of a service 
by running the following command at the Windows command prompt, from 
the <installation path> \Service Manager 7.00\Server\ 
LegacyIntegration\RUN directory.  
scenter -listener:<port number> -RPCReadOnly
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Installing the ODBC Driver

Follow these steps to install the legacy ServiceCenter ODBC driver.

1 Log in to the Windows server as a user with local administrator privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

3 If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. 

4 If auto-run is disabled, follow these steps to start the DVD browser 
manually.

5 Navigate to the DVD directory. 

6 Open clickme.htm.

7 Click Install ODBC Driver.

The ServiceCenter ODBC Driver InstallShield Wizard opens.

8 Click Next to read and accept the licensing agreement.

9 Select the I accept the terms in the License Agreement option.

The Next button becomes active.

10 Click Next to select your installation folder. 

The default installation location is:

C:\Program Files\Peregrine Systems\ServiceCenter 6.2\ODBC Driver

If necessary, click Browse to choose a different location.

11 Click Next to prepare the installation process.

12 Click Install to begin copying the installation files.

You can stop the installation by clicking Cancel.

A dialog box opens when the installation is complete. 

13 Click Finish to exit.
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Configuring the ODBC Driver

The default installation sets up the ODBC DSN to connect to the default 
legacy listener, and assumes it is on the local host. To connect to your legacy 
listener, you will need to edit these settings.

Follow these steps to configure the legacy ODBC driver to connect to the 
legacy read-only listener:

1 From the Windows Start menu, click Control Panel > Administrative Tools > 
Data Source (ODBC).

2 Open the System DSN tab.

3 Select sc_report_odbc and click Configure.

4 Configure the ODBC driver by using the following parameters.

5 Verify that the ODBC driver can connect. 

To test the connection, use any ODBC query tool. For example, in Excel, 
open: Data > Get External Data > New Database Query. Choose 
the ServiceCenter ODBC driver as your data source. If it connects, you 
will see the HP Service Manager tables.

Table 4 ODBC parameters

Field Value

Data Source Name sc_report_odbc

Server The host where the legacy ServiceCenter listener is 
running. 
The out-of-box default is localhost.

Port The port the legacy server is set to use. 
 The out-of-box default is 12690.
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Crystal Reports

The Service Manager installation DVD comes with out-of-box reports that you 
can run using Crystal Reports. Using those reports requires the ServiceCenter 
ODBC driver. This driver is installed when you run the Service Manager 
ODBC driver installer. 

Follow these steps to download the reports.

1 Log in to the Windows server as a user with local administrator privileges.

2 Insert the Service Manager installation DVD into the appropriate drive of 
the server.

If you are installing on a system that has auto-run enabled, the DVD 
browser starts automatically. If auto-run is disabled, follow these steps to 
start the DVD browser manually.

a Navigate to the DVD directory. 

b Open clickme.htm.

3 Select the Downloads tab.

4 Click Download Reports for HP Service Manager. 

A folder containing the available reports opens. 

5 Copy the desired reports to your local directory.

Refer to your Crystal Report documentation for information on how to run the 
reports. 
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